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Chapter 29: Fonts

Fonts
Most items you see in Finale are created with font characters. In addition to items created with 
text, musical symbols (such as noteheads, clefs, and expressions) are font characters as well. 
Finale is unique among music notation programs in that it allows the user to specify the font used 
for music characters. This means you can choose from different note heads, different treble clefs, 
or whatever you'd like, to make your music look exactly the way you want it to. Furthermore, 
within lyrics, text blocks, chord symbols, and the Shape Designer you are able to mix fonts freely: 
you could, for example, combine text characters with musical symbols, or have selected lyrics 
italicized.

PostScript, TrueType and ATM (Adobe Type Manager)
All fonts included with Finale come with a Type 1 PostScript font and a True Type font. A Post-
Script font does not appear on screen and will only print to PostScript printers, where it provides 
superior printed output. TrueType fonts allow you to print to non-postscript printers as well as 
resize smoothly in both printout and on screen. TrueType fonts do not work, however, in the cre-
ation of EPS (Encapsulated PostScript) files. A full installation of Finale installs both the Post-
Script and TrueType fonts in your system.

Prior to the introduction of TrueType fonts, Finale came with bit map fonts which provided an on-
screen representation of how the PostScript fonts would print, as well a provide a way to print to 
non-postscript printers. Bit map fonts don't resize smoothly on screen or in printout, meaning that 
a 24 point font will look okay at 100 percent, but jagged at other point sizes, page reductions or 
view percentages. Adobe Type Manager (ATM) provided a solution: it helped to smoothly resize 
fonts on screen and in non-postscript printer output. With the inclusion of TrueType fonts, ATM is 
not necessary for the use of any of the fonts included with Finale, but may be useful if you choose 
to print other PostScript fonts to non-PostScript printers.

Where are the fonts installed?
The Finale Installer automatically installs the Maestro, Maestro Wide, Maestro Percussion, 
Petrucci, Tamburo and Engraver Fonts TrueTypes directly into your Fonts folder located in your 
Windows folder. The PostScript fonts are installed in a folder called PS fonts, located on your root 

directory (usually c:\). If, when you open Finale, large text symbols like & and Ï appear instead 
of clefs and notes, Windows is unable to locate the Maestro font. The solution is to go to the Fonts 
Control Panel and manually add the Maestro font to your system. (Note that PostScript font instal-
lation is printer specific and that the PostScript fonts are only visible to the printer that was 
selected as the default printer when the fonts were installed.)

How to identify font types
PostScript fonts are recognized by .PFM or .PFB extensions. TrueType fonts have a TT icon, and 
.TTF extensions, and Windows will create corresponding files with .fot extensions.

Additional discussions of fonts and font selections appear in individual entries, such as LYRICS; 
NOTEHEADS; EXPRESSIONS; TEXT; and so on.
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To globally change a musical element’s font
With this technique you can change the font for a single element of the music, such as the clefs or 
the notes themselves. If you want to change all elements of the music to a different font, see “To 
change music fonts,” below.

• Choose Select Default Fonts from the Options Menu. The Select Default Fonts dialog box 
appears, with buttons and drop-down lists for various elements of the file. The Select Font but-
ton refers to the font used for the notes, rests, accidentals, and other musical symbols; if you 
use this button to substitute a music font of your own design, you’ll need to make some adjust-
ments using the Music Characters dialog box in the Document Settings Submenu of the 
Options Menu as well. (Finale makes the necessary adjustments automatically if you specify 
Maestro, Petrucci, Engraver or Sonata as your default music font.) See SELECT DEFAULT 
FONTS DIALOG BOX.

• From the drop-down lists, choose the musical element whose font you want to change. 
Then click the Set Font button and the Font dialog box appears. Choose the font name, type, 
and point size, you’ll see the sample text change in the display below. You can choose any 
combination of style elements: bold, italic, and so on.

• Click OK (or press enter) twice. 

To change music fonts
If you choose not to use Finale’s own font, Maestro, you can substitute any other music font.

• Choose Select Default Fonts from the Options Menu. The Select Default Font dialog box 
appears.

• Click the Set Default Music Font button. The Font dialog box appears.
• Choose the new font and style; click OK twice. Depending on the music font you’ve 

selected, you may have to fine-tune the positions of individual elements, such as the eighth-
note flags. For details, see MUSIC CHARACTERS DIALOG BOX. If you want to change other ele-
ments to another font, such as JazzText or JazzCord, continue with the instructions below.

• From the Options Menu, choose Data Check, then Swap One Font For Another. The 
Swap Font dialog box appears.

• Select the text font you want to change by clicking the top Set Font button. Select the text 
font you want by clicking the bottom Set Font button. For example, select Times New 
Roman mixed sizes and styles for the Search For font and Jazz Text mixed sizes and styles for 
the Replace font.

• To change chords, choose Select Default Fonts from the Options Menu. The Select 
Default Font dialog box appears.

• From the drop-down lists next to Chord, choose Symbol. Click Set Font and choose Jazz-
Cord or the desired chord font.

• Click OK (or press enter) twice.

• Click the Chord Tool X. The Chord Menu appears.

• From the Chord Menu, choose Change Chord Suffix Fonts.
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• To change the entire library of chord suffixes at once, click the Set Font button in the 
lower half of the screen. The Font dialog box appears, letting you specify new font, size, and 
style characteristics for the suffixes. For best results, be sure that the Fix Chord Suffix Spacing 
checkbox is selected, so that Finale automatically adjusts the individual characters in each 
chord suffix to compensate for the new font and size.

• Select a type style, and then click OK. You return to the score, where Finale has changed the 
font for your chord suffixes. Finale is smart enough, however, not to change any musical sym-
bols within the suffix, such as the f in F7f9.

To change every occurrence of one font to another
You can use Finale’s Data Check submenu to change every occurrence of one font and size to 
another, no matter where they occur—in symbol libraries, in text, in chord symbols, and so on. 
See also CHANGE FONTS PLUG-IN.

• Click Swap One Font for Another... from the Data Check submenu of the Options Menu. 
In the dialog box that appears, you can instruct Finale to search for a specific font and replace 
it with another. 

• Specify the font to be replaced and the font to replace it with, and click OK. 

To change every occurrence of a font to a different size
With this technique, you can scale every occurrence of a certain font that’s used in your document 
to a larger or smaller font size, no matter what size was used in each occurrence. For example, you 
could tell Finale to scale every occurrence of New York 24-point down to 12-point. In so doing, 
Finale would also scale New York 36-point down to 18-point, and New York 10-point down to 5-
point. 

• Click Scale Fonts... from the Data Check submenu of the Options Menu. In the dialog box 
that appears, you can instruct Finale to search for a specific font, style and size and then 
replace it with the same font of a different size. All occurrences of this font will change in size 
proportionally.

• Specify the font, style and size you want changed and Click OK (or press enter). 
• Specify the point size you want the specified font to be scaled to, and click OK (or press 

enter). If you want this process to work properly, specify the same font in this dialog box as 
you did in the last one, but enter a different size.

• Choose the new font and style and click OK; click Done. 

To change the music font of noteheads on a staff by staff basis
To use Tamburo for your percussion notation, assign it as the notehead font in each staff or as the 
document’s default notehead font. Then, take advantage of Finale’s built-in percussion libraries or 
create one of your own, so that notes you enter on a percussion staff automatically assign them-
selves to appropriate lines or spaces with the correct noteheads. For details, see PERCUSSION.

• Click the Staff Tool s. 

• Double-click the staff. The Staff Attributes dialog box appears.
• Click the Notehead Font checkbox if it is not already selected. 
• Click Select and choose the new font. 
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• Click OK twice to return to the score. Your new font is now being used for noteheads while 
other elements such as flags and clefs are taken from the default music font(s).

To eliminate dimmed font names from a document’s font lists
Finale stores a font list with each document you create. The list contains the fonts that were avail-
able to Finale when the document was created. If you notice that some font names are dimmed in 
the font selection boxes of a certain document, it’s because those fonts were present when the doc-
ument was created (or previously edited) but are no longer installed.

This procedure removes dimmed font names from a document’s font selection boxes.
• Choose Check Document Fonts Against System Fonts from the Data Check submenu of 

the Options Menu. 

Change Fonts Plug-in
How to get there

Select Change Fonts from the Plug-ins Menu. See PLUG-INS MENU for more information on plug-

ins.

What it does
The Change Fonts plug-in allows you to change the font globally for specific items in your score 
such as Lyrics (verses, choruses, and sections), Text Blocks, and Staff or Groups Names.
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• Change. Click on the button next to the item for which you would like to change the font. The 
Font dialog box appears where you can set the Font, Size, and Style. See FONT DIALOG BOX 
for more information. The current font selection is displayed in the dialog box next to the 
item.

• Individually Change Lyrics. Select this checkbox if you would like to change the font indi-
vidually on sections, verses or choruses.

• OK • Cancel. Click OK to change the font on the selected items. Click Cancel to return to the 
score without making any changes.
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Engraver Font
The Alternate Notehead Sets
“Let Ring” Noteheads.
These are noteheads with the let ring symbol. By having the let ring symbol directly attached to 
the notehead, consistency of the symbol placement is achieved. These noteheads can be accessed 
through the Special Tools Tool (change notehead). First enter the notes with any of the Finale note 
entry methods, then with Special Tools Tool change the notehead.  

Example:       

Also included are the two “let ring” symbols for input with the articulation tool.

Engraver Font Set and Engraver Font Extras Engraver Font Extras Only

0131

0132

0133

0134

0135

0136

0137

0138

0139

0142

0143

0144

0145

0146

0147

0148 

0149

0150

0151

0152

0153

0154

0155

0156

0157

0158

0159

0193 

0170

0163

0162

0176

0164

0166

0165

0187

0218

0219

0220

0221

0222

0223

0224

0161

0225

39

34

0190

0174

I
i   

sh-I
I    

É

Ñ

Ö

Ü

.
á

.
à

.â

.ä

.
ã

é

è

ê

ë

.
í

.
ì

.î

.ï

.
ñ

ó

ò

ô

ö

.
õ

.
ú

.ù

.û

.
ü

¡

™

£

¢

.∞

.§

.¶

.•

.ª

⁄

¤

‹

›

.fi

.fl

.‡

.°

.·

'

"

.æ

.Æ

œ
œ
œ

É
É
Ñ

.

.

.

˙
˙
˙

.

.

.

î
î
ï

w

w

w

ô

ó

ö
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“Double-stopped unison” Noteheads. 

“Trill to” Noteheads
Set One: Full Size

These noteheads are to make consistent the process of setting up “trill to” notes when they are to 
be outside of the staff. First enter the notes with any of the Finale note entry methods, then with 
Special Tools Tool change the notehead, shorten the stem and move it to the desired horizontal 
position.

Set Two: 75% Reduction

These noteheads are already reduced to 75% and can be used as “trill to” notes for use within the 
staff. Enter with the Articulation Tool.

sh-Q

sh-H

X
    

Q

H

x

sh-L

L l

L

¬

Ò

0194

0241

Ÿ~~~~~~~~~

˙
L

¥

   Y

 sh-Y

y

Y

Á

0180

0231

Ÿ~~~~~~~~

˙
Y
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Indeterminate and Determinate “Tone-cluster” Noteheads
These noteheads allow for a quick and consistent way to input tone-clusters. After inputting notes, 
use the Special Tools Tool to change the noteheads.

Indeterminate

Determinate

 for use in quarter and half note clusters

 for use in whole note clusters                     

Dynamics
Type away! Make whatever dynamic possible.

ex.   fffffffffffffff        

There are two sets of parenthesis for use. The f and p markings need more space than the other 

symbols, so use the shift-[ and shift-] both before and after any dynamic with an f and before any 

marking with a p.

;

 sh - ;

;

:

…

Ú

0201

0242

œ
œ
œ

Ú
Ú
Ú

œ
œ
œ
œ
œ

Ú
Ú
Ú
Ú
Ú

˙
˙
˙

;
:
…

˙
˙
˙
˙
˙

;
:
:
:
…

“0210
˙
˙
˙
˙
˙

#

b

˙
“
“
“
˙

#

b

”0211
w
w
w
w
w

b

#

w
”
”
”
w

b

#
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Articulations
Engraver Font Set

Engraver Font Extras

0190 0188 D sh-D E sh-E

tremolos
æ º d D e E 

0193 0170 0163 0162 0176 0164 0166 0165

brackets
¡ ™ £ ¢ ∞ § ¶ •

0169 0253

Bartok pizz.
© ˝

0187

system divider
ª

[ ] sh-[ sh-]

conducting symbols
[ ]

= 1 beat
{ }

= 2 beats

0210 0212 0211

“ ‘

= 3 beats
”

= 4 beats

0185

harp mute
π

, sh - , .

trills
, < .

\ sh-\ ; sh-; ` sh-`

(within staff) articulations
\ | ; : ` ~

œ

\

œ

\

œ

;

œ

;

œ

`

œ

`

ex.
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Engraver Text Fonts
Tempos

Q = q C = c \ = \ (use with quarter and half notes)

H = h M = m sh-\ = | (use with quarter and half notes)

E = e (0130) = Ç ; = ; (use with whole notes)

X = x D = d (use with quarter and half notes) sh-; = : (use with whole notes)

W = w (0235) = Î  (use with whole notes)

U = u sh-[= {

V = v sh-] = }

B = b

examples: q=100 {h=60} q|qd

Harp Pedaling
Single Line

F = f, S = s, N = n

sh-A = A, etc.

L = l

example: DsCsBnlEnFsGsAs

Double Line

(above plus)

G = gg, sh-S = S, sh-N = N (0186) = ∫, (0141) = ç, (0182) = ∂,

K = k, R = r, sh-R = R

/ = (space for letter), sh-/ = (space for accidental)

examples: kE∂nSFçsSG∫sNAs

rE∫nNR

Graphic
O = o, sh-O = O, P = p sh-P = P

example: ppOPOppp
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Maestro Font
Notes and Augmentation Dot

Notes and Augmentation Dot

Keystroke Character Description Keystroke Character Description

Shift-W
W 

Double Whole Note 
(Breve)

Shift-E
E

Eighth Note - Down-
stem

Alt+0135
á

Alternate Double 
Whole Note (Breve)

X
x

Sixteenth Note - 
Upstem

Alt+0221
›

Breve Shift-X
X

Sixteenth Note - 
Downstem

W
w

Whole Note Alt+0169
©

Small Quarter Note - 
Upstem

H
h

Half Note - Upstem Alt+0237
Ì

Small Quarter Note - 
Downstem

Shift-H
H

Half Note - Down-
stem

;
;

Small Eighth Note 
(Grace Note)- Upstem

Q
q

Quarter Note - 
Upstem

Shift-;
:

Small Eighth Note 
(Grace Note)- Down-
stem

Shift-Q
Q

Quarter Note - Down-
stem

Alt+0201
…

Slashed Grace Note

E
e

Eighth Note - Upstem Alt+0242
Ú

Small Quarter Note 
Equals
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Noteheads
Noteheads

Keystroke Character Description Keystroke Character Description

.
.

Augmentation Dot Alt+0231
Á

Right-facing Triangle

Alt+0250
˙

Half Notehead Alt+0224
‡

Filled Upside Down 
Triangle

Alt+0207
œ

Quarter/Eighth Note-
head

Alt+0225
·

Diamond

Alt+0192
¿

Non-pitched notehead Alt+0226
‚

Filled Diamond

Y
y

Triangle Alt+0208
–

Filled Square

Alt+0198
∆

Upside Down Trian-
gle

Alt+0209
—

Filled Triangle

L
l 

Left-facing Triangle Alt+0173
≠

Square

Shift-L
L

Circle Alt+0231
Á

Right-facing Triangle

Alt+0194
¬

Rectangle Alt+0224
‡

Filled Upside Down 
Triangle

Alt+0180
¥

Angled rectangle
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Flags
Flags

Keystroke Character Description Keystroke Character Description

J
j

First Upstem Flag R
r

Sixteenth Note 
Upstem Flag

Shift-J
J

First Downstem Flag Shift-R
R

Sixteenth Note 
Downstem Flag

Shift-K
K

Second Upstem Flag Alt+0251
˚

Second Upstem Flag - 
Old

Alt+0239
Ô

Second Downstem 
Flag

Alt+0240
 

Second Downstem 
Flag - Old

Alt+0144
ê

Sixteenth Note 
Upstem Flag (Use 
Petrucci secondary 
flag setting)

Alt+0146
 í

Sixteenth Note 
Downstem Flag (Use 
Petrucci secondary 
flag setting)

Alt+0145
ë

Second Upstem Flag 
(Use Petrucci second-
ary flag setting)

Alt+0147
 ì

Second Downstem 
Flag (Use Petrucci 
secondary flag set-
ting)
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Accidentals
Accidentals

Keystroke Character Description Keystroke Character Description

Shift-3
#

Sharp Alt+0233
È

Small Natural

A
a

Courtesy Sharp Alt+0210
“

Small Courtesy Natu-
ral

Shift-I
I

Small Sharp Alt+0186
∫

Double-Flat

[
[

Small Courtesy Sharp Alt+0140
å

Courtesy Double-Flat

B
b

Flat Alt+0211
”

Small Courtesy Dou-
ble-Flat

Shift-A
A

Courtesy Flat Alt+0220
‹

Double-Sharp

I
i

Small Flat Alt+0129
Å

Courtesy Double-
Sharp

Shift-[
{

Small Courtesy Flat [
]

Small Courtesy Dou-
ble-Sharp

N
n

Natural Alt+0245
ı

Quarter Tone Flat

Shift-N
N

Courtesy Natural Shift-4
$

Quarter Tone Sharp
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Rests

Dynamics

Rests

Keystroke Character Description Keystroke Character Description

Alt+0227
„

Double-Whole Note 
Rest

Alt+0197
≈

Sixteenth Note Rest

Alt+0183
∑

Whole Note Rest Alt+0168
®

Thirty-Second Note 
Rest

Alt+0238
Ó

Half Note Rest Alt+0244
Ù

Sixty-Fourth Note 
Rest

Alt+0206
Œ

Quarter Note Rest Alt+0229
Â

One Hundred 
Twenty-Eighth Note 
Rest

Alt+0228
‰

Eighth Note Rest

Dynamics

Keystroke Character Description Keystroke Character Description

F
f

Forte Alt+0141
ç

Sforzando

Shift-F
F

Mezzo forte Alt+0130
Ç

Sforzando-piano

Alt+0196
ƒ

Fortissimo Alt+0182
∂

Sforzando-pianissimo

Alt+0236
Ï

Fortississimo S
s

s for dynamic combi-
nations
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Alt+0235
Î

Louder than Fortissis-
simo

Shift-S
S

Sforzando or Sforzato

P
p

Piano Alt+0167
ß

Sforzando or Sforzato

Shift-P
P

Mezzo piano Alt+0234
Í

Forte-piano

Alt+0185
π

Pianissimo Z
z

z for dynamic combi-
nations

Alt+0184
∏

Pianississimo Shift-Z
Z

Forzando

Alt+0175
Ø

Softer than Pianissis-
simo

Alt+0189
Ω

m for dynamic combi-
nations

Alt+0142
é

r for dynamic combi-
nations

Alt+0150
ñ

n for dynamic combi-
nations

Dynamics

Keystroke Character Description Keystroke Character Description
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Articulations
Articulations

Keystroke Character Description Keystroke Character Description

.
.

Staccato Alt+0248
¯

Tenuto with Staccato

Shift-.
>

Accent Shift-U
U

Fermata - Above

Alt+0223
fl

Accent with Staccato U
u

Fermata - Below

Alt+0249
˘

Accent with Staccato Shift-`
~     

Trill

V
v

Marcato Alt+0217
Ÿ

Trill

Shift-6
^

Marcato M
m       

Mordent, Trill

Alt+0172
¨

Marcato with Stac-
cato

Shift-M
M

Mordent

Alt+0232
Ë

Marcato with Stac-
cato

Alt+0178
≤

Upbow

-
-

Tenuto Alt+0179
≥

Downbow

Shift-,
<

Tenuto with Staccato Shift-T
T

Grupetto (Turn)
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Alt+0161
°

Pedal Down Shift-1
!

Measured Tremolo

Shift-8
* 

Pedal Up Shift-2
@

Measured Tremolo

G
g

Rolled Chord - 
Arpeggio

Alt+0190
æ

Unmeasured Tremolo

Shift-’
"

Caesura (Pause, Rail-
road tracks)

Shift-9
(

Left Parenthesis

Alt+0201
…

Slashed Grace Note Shift-0
)

Right Parenthesis

O
o

Natural Harmonic '
'

Rounded Marcato

Shift-O
O

Harmonic Alt+0174
Æ

Rounded Marcato

Alt+0132
Ñ

Augmented Alt+0171
´

Marcato

,
,

Pause (Breath Mark) Alt+0216
ÿ

Marcato

Alt+0133
Ö

Pause (Breath Mark) Alt+0137
â

Accented Tenuto

Alt+0181
µ      

Mordent, Trill Alt+0138
ä

Accented Tenuto

Articulations

Keystroke Character Description Keystroke Character Description
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Smart Shapes

Repeats and Alternate Notation

Smart Shapes

Keystroke Character Description Keystroke Character Description

Alt+0195
√

Ottava `
`

Double Ottava basso

Alt+0215
◊

Ottava basso Alt+0134
Ü

Double Ottava

Alt+0131
É

Ottava Alt+0217
Ÿ

Trill

Alt+0219
¤

Double Ottava Shift-`
~     

Trill

Repeats and Alternate Notation

Keystroke Character Description Keystroke Character Description

Shift-5
%

Segno Alt+0213
’

 Large Slash

Alt+0222
fi

“To Coda” Alt+0243
Û

 Small Slash

Alt+0212
‘

Measure Repeat Shift-\
|

 Whole and Half Note 
Diamond

Alt+199
«

Two-Measure Repeat Alt+0218
⁄

Double Whole Note 
Diamond

Alt+159
ü

Segno Alt+203
À

Slash
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Clefs

Staves and Barlines

Clefs

Keystroke Character Description Keystroke Character Description

Shift-7
&

G Clef T
t

Bass 8vb

Shift-B
B

C Clef Alt+0160
†

Treble 8va

Shift-/
?

F Clef Alt+0230
Ê

Bass 8va

Alt+0214
÷

Percussion Clef /
/

Natural Clef

Shift-V
V

Treble 8vb Alt+0139
ã

Percussion Clef

Staves and barlines

Keystroke Character Description Keystroke Character Description

=
=          

Staff Lines Alt+0241
Ò

Dotted Barline

\
\

Barline Shift - -
_

Ledger Line
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Time Signature and Multimeasure Rest numbers

Chord Symbols and Harmonics

Time Signature and Multimeasure Rest numbers

Keystroke Character Description Keystroke Character Description

C
c

Common Time 6
6

Number 6

Shift-C
C

Cut Time 7
7

Number 7

1
1

Number 1 8
8

Number 8

2
2

Number 2 9
9

Number 9

3
3

Number 3 0
0

Number 0

4
4

Number 4 Alt+0246
ˆ

Plus sign

5
5

Number 5 Sh-=
+

Plus sign

Chord Symbols and Harmonics

Keystroke Character Description Keystroke Character Description

Alt+0132
Ñ

Augmented Chord Alt+0191
ø

Half Diminished 
Chord

Alt+0247
˜

Diminished Chord Alt+0177
±

Major Chord
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Percussion Notation

Other Notation Symbols

Percussion Notation

Keystroke Character Description Keystroke Character Description

Y
y

Cymbal - Closed 
Notehead

Shift-Y
Y

Cymbal - Open Note-
head

Other Notation Symbols

Keystroke Character Description Keystroke Character Description

K
k

Dot Shift - ]
}

Closed Parenthesis

Shift-G
G

Acute Alt+0200
»

Equal sign

Alt+0193
¡

Small 1 Alt+0164
§

Small 6

Alt+0170
™

Small 2 Alt+0166
¶

Small 7

Alt+0163
£

Small 3 Alt+0165
•

Small 8

Alt+0162
¢

Small 4 Alt+0187
ª

Small 9

Alt+0176
∞

Small 5 Alt+0188
º

Small 0

Alt+0136
à

Colon for italic num-
bers
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Jazz Text Font
Below is a list of the special characters and their keystrokes. The primary special characters in the 
text font are brackets and musical notes. Use the “in-between” characters for longer words or 
extended phrases. All the standard letter, number and shift text characters are mapped to the same 
letter or number in the Jazz Text Font.

Brackets

Keystroke
Right 

bracket
s

Keystroke
Middle 

brackets
Keystroke

Left 
bracket

s

Examples: Type the 
first line to get the 

second

[ [   \  \  ]  ] [H\a\r\m\o\n\ \m\u\t\e]

[H\a\r\m\o\n\ \m\u\t\e]

Shift-[ {   Shift-\  |    Shift-]   } {S|o|l|o}

{S|o|l|o}

Shift-` ~   ~1}

~1}

Alt+0128 Ä       Alt+0129  Å       Alt+0130      Ç left bracket, character, mid-
dle, character... right 
bracket

Ä2nÅdÅ ÅTÅiÅmÅeÅ ÅOÅnlyÇ

Alt+0133 Ö       Alt+0134  Ü        Alt+0135     ªá left bracket, character, mid-
dle, character... right 
bracket

ÖTÜaÜkÜeÜ ÜRÜeÜpÜeÜaÜtÜ ÜoÜnÜ D.S.á

Alt+0150 ñ    Alt+0151   ó   Alt+0152  ò left bracket, character, mid-
dle, character... right 
bracket

ñSótóaórótó óHóeóróeò

Alt+0154 ö       Alt+0155  õ        Alt+0156      ú left bracket, character, mid-
dle, character... right 
bracket

öDõ.õSõ.õ õaõlõ Fineú
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Alt+0157 ù     Alt+0158  û    Alt+0159    ü left bracket, character, mid-
dle, character... right 
bracket

ù1ûsûtû ûTûiûmûeû ûOûnlyü

Alt+0160 †       Alt+0161  °       Alt+0162      ¢ left bracket, character, mid-
dle, character... right 
bracket

†R°e°p°e°a°t° °f°o°r° solos¢

Alt+0163 £   Alt+0164  §    Alt+0165   • left bracket, character, mid-
dle, character... right 
bracket

£F§i§n§e•

Alt+0166 ¶       Alt+0167  ß       Alt+0168       ® left bracket, character, mid-
dle, character... right 
bracket

¶3ßrßdß ßchorus®

Alt+0175 Ø     Alt+0176  ∞ Alt+0177   ± left bracket, character, mid-
dle, character... right 
bracket

Ø1∞s∞t∞ ∞X±

Alt+0178 ≤       Alt+0179 ≥        Alt+0180       ¥ left bracket, character, mid-
dle, character... right 
bracket

≤R≥e≥p≥e≥a≥t≥ ≥f≥o≥r≥ ≥solos¥

Alt+0181 µ       Alt+0182  ∂        Alt+0183      ∑ left bracket, character, mid-
dle, character... right 
bracket

µS∂t∂a∂r∂t Here∑

Brackets

Keystroke
Right 

bracket
s

Keystroke
Middle 

brackets
Keystroke

Left 
bracket

s

Examples: Type the 
first line to get the 

second
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Multimeasure Rests

Keystroke
Right 

bracket
s

Keystroke
Middle 

brackets
Keystroke

Left 
bracket

s

Examples: Type the 
first line to get the 

second

Alt+0170 ™  Alt+0171 ´ Alt+0172 ¨    ™ 8 bars ¨ 

™´´´´¨   

Rehearsal Letters

Keystroke Character Description Keystroke Character Description

Alt+0216 ÿ A Alt+0217 Ÿ B

Alt+0218 ⁄ C Alt+0219 ¤ D

Alt+0220 ‹ E Alt+0221 › F

Alt+0222 fi G Alt+0223 fl H

Alt+0224 ‡ I Alt+0225 · J

Alt+0226 ‚ K Alt+0227 „ L

Alt+0228 ‰ M Alt+0229 Â N

Alt+0230 Ê O Alt+0231 Á P

Alt+0232 Ë Q Alt+0233 È R

Alt+0234 Í S Alt+0235 Î T
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Alt+0236 Ï U Alt+0237 Ì V

Alt+0238 Ó W Alt+0239 Ô X

Alt+0240  Y Alt+0241 Ò Z

Music Notation Items

Keystroke Character Description Keystroke Character Description

Alt+0140 å Quarter Note Alt+0141 ç Half Note

Alt+0142 é Whole Note Alt+0139 ã Quarter Note = 

Alt+0137 â Eighth Note Alt+0138 ä Sixteenth Note 

Alt+0132 Ñ Flat Alt+0136 à Natural

Alt+0243 Û Coda with enclosure Alt+0244 Ù Dal Segno with enclosure

Alt+0245 ı Coda Alt+0246 ˆ Dal Segno

Alt+0242 Ú Blank enclosure

Other Text Items

Keystroke Character Description Keystroke Character Description

Alt+0192 ¿ 1 Alt+0193 ¡ 2

Rehearsal Letters

Keystroke Character Description Keystroke Character Description
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Double whole notes
The double whole note, or breve (v or b ) has a duration of eight beats. Either notehead may 
also be use to represent recitative on a single pitch. See NOTE VALUES (DURATIONS) for informa-
tion on creating double whole notes.

Alt+0194 ¬ 3 Alt+0195 √ 4

Alt+0196 ƒ 5 Alt+0197 ≈ 6

Alt+0198 ∆ 7 Alt+0199 « 8

Alt+0200 » 9 Alt+0191 ø 0

Alt+0201 … 1st Chorus Alt+0205  Õ 2nd Chorus

Alt+0203 À 3rd Chorus Alt+0204 Ã 3rd Chorus

Alt+0131 É Fine Alt+0153 ô ™

Alt+0169 © © Alt+0174 Æ ®

Alt+0145 ë Single quote Alt+0146 í Single quote

Alt+0147 ì Double quote Alt+0148 î Double quote

Alt+0188 º 1/4 Alt+0189 Ω 1/2

Alt+0190 æ 3/4 Alt+0215 ◊ X

Other Text Items

Keystroke Character Description Keystroke Character Description
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To substitute the b notehead for the v notehead globally
Follow these instructions if you want Finale to use the b default v notehead for the double 
whole note.

• Choose Music Characters from the Document Settings submenu of the Options Menu. 
The Music Characters dialog box appears.

• From the Note Heads drop-down list, choose Double Whole; click Select. Finale displays 
the Symbol Selection dialog box containing every symbol in the Maestro music font.

• Double-click the b notehead. You return to the dialog box.
• Click OK (or press enter). 

To substitute the b notehead on a note-by-note basis
See NOTE SHAPES—To change the shape of a notehead.

Shape Note music
In some hymnal music, each note of the scale has its own notehead, regardless of key. In Tamburo, 
noteheads for these “shape notes” are found on the number keys 1 through 9. To set up the staff 
for Note Shapes, click on the Options Menu and choose Document Settings, then Note Shapes. 
See NOTE SHAPES DIALOG BOX for more information. You can also use the Shape Note Hymnal 
template. See TEMPLATES. Each number corresponds to the appropriate scale tone—the tonic 
shape note is found on 1, the second shape note on 2, and so on. Since some shape note conven-
tions differ, we offer two choices for the fourth scale degree, one shape on 4 and the other on 9.

Flags
See also BEAMING; STEMS.

You have considerable control over the flags on single eighth notes (and smaller values) in Finale. 
The typical use for these parameters is to adapt a music font to Finale other than Finale’s Maestro 
font or Adobe’s Sonata font. Because different fonts use different spacing and positioning 
schemes for their music characters, you may need to adjust some of these variables in order to 
accommodate a different music font.

To change the character assignment for a flag
• Choose Music Characters from the Document Settings submenu of the Options Menu. 

The Music Characters dialog box appears.

• From the Flags drop-down list, choose the flag element whose character you want to 
change, then click Select. See the figure for reference.

Key 1 2 3 4 5 6 7 8 9

Alone
1 2 3 4 5 6 7 8 9

With Shift
! @ # $ % ^ & * (
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When you click Select, the Symbol Selection dialog box appears containing every available 
character in the font. (To change the font whose characters you’re viewing, choose Select 
Default Fonts from the Options Menu and click the Set Default Music Font button.)

• Double-click the replacement character. Whichever character you select will now appear at 
every occurrence of a flag in this document.

• Click OK (or press enter). 

To use Straight Flags
• Choose Select Default Fonts from the Options Menu. 

• Choose Flags from the Notation drop-down list. 

• Click Set Font, and choose Tamburo. 

• Click OK twice. You return to the score, where Finale displays all flags in your score 
using the Tamburo font. 

• Choose Music Characters from the Document Settings submenu of the Options Menu. 

• Click the Straight Flags checkbox to select it. 

• Choose Straight Upstem Flag from the drop-down list, then click Select to display the 
Symbol Selection dialog box. Type the key combination for the character, or scroll through 
the dialog box and click the character you want to use. Click Select to choose the Straight 
Upstem Flag character. Choose the characters according to the tables below, then click select.

• Choose Straight Downstem Flag from the drop-down list, then click Select to display the 
Symbol Selection dialog box. Type the key combination for the character, or scroll through 
the dialog box and click the character you want to use. Click Select to choose the Straight 
Downstem Flag character. Choose the characters according to the tables below, then click 
select.

If you’re using Horizontal Straight Flags, use the flag character on R (slot number 114) in the 
Tamburo font for both the straight upstem and downstem flag. For Angled Straight Flags, use 
the flag character S (slot number 115) for the straight upstem flag, and shift-S (slot number 83) 
for the straight downstem flag. Use the Music Character Positioning dialog box to adjust the 
horizontal or vertical placement of the flags as needed. Refer to the following tables to deter-
mine which characters to select for the angled or horizontal style of straight flags.

Angled Straight Flag
Slot 

numbe
r

Key Cap

Straight Upstem Flag 115 S

Straight Downstem Flag 83 shift-S

x

X

First Upstem Flag

Second Upstem Flag First Downstem Flag
Second Downstem Flag
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To adjust the placement of Horizontal and Angled Straight Flags
• Choose Music Characters from the Document Settings submenu of the Options Menu. 
• Click Positioning in the Music Characters dialog box. 
• Choose Straight Upstem Flag from the drop-down list and change V to 12 EVPUs. (For 

angled straight flags, set V to 24 EVPUs.)
• Choose Straight Downstem Flag from the drop-down list and change V to zero. (For 

angled straight flags, set V to -24 EVPUs.)
• Click OK twice to return to the score. 

Unknown Font dialog box

How to get there
From the File Menu, choose Open Library. Double-click the name of a library that was created 
with a font that’s no longer installed in your System file.

What it does
You’ll encounter this dialog box when you try to open a library of symbols or expressions that 
were created with fonts that are no longer installed, or a library that was created on someone else’s 
computer (with a different set of fonts installed). Finale gives you two options for handling the 
missing fonts. You can either select a new font to replace the missing one, or you can tell Finale to 
go ahead and load the library, substituting the System font for the missing fonts until you later 
install the missing font into your Windows Font folder. At that point, the library elements will 
reappear in their original fonts.

Horizontal Straight 
Flag

Slot 
numbe

r
Key Cap

Straight Upstem Flag 114 R

Straight Downstem Flag 114 R
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• Add the Font to the Font List. Click this button if you want Finale to display the library ele-
ment in the system font until such time as the missing font is reinstalled.

Finale doesn’t actually install a font in your system when you click Add. Instead, it adds the 
missing font’s name to its font selection boxes; it will appear dimmed (like the names of any 
other missing fonts). When you later install the missing font in your System, its name will no 
longer be dimmed, and the library elements in question will reappear in their original fonts 
(instead of the substitute font).

• Select Another Font. Click this button if you want to substitute a different font for the one 
that’s missing. Finale responds by displaying the Font dialog box, in which you can select the 
new font.

If there are other fonts that were used to create the library (that are now missing), Finale dis-
plays the Font dialog box again so that you can repeat the process.

• OK • Cancel. Click OK (or press enter) to do the selected action. Click Cancel to return to the 
score without making any changes.

Alternative music fonts
The following is a list of some of the fonts which are available to the Finale user:

Maestro, Maestro Percussion and Maestro Wide (included with the purchase of Finale)

Finale’s default music font developed for Coda Music Technology by Blake Hodgetts (see also 
TOCCATA AND FUGHETTA). This is an elegant font, yet more robust than Petrucci, more accurately 
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representing the look of engraved music. Maestro Wide is identical with the exception of wider 
noteheads.

Petrucci (included with the purchase of Finale, Finale Allegro, or Finale PrintMusic!)

This music font is called Petrucci, named for Ottaviano Petrucci, the sixteenth-century Italian who 
first used movable type for printing polyphonic music. It was the default music font for Finale 
products for years, but is now shipped for compatibility.

Tamburo (included with the purchase of Finale)

Tamburo, an Italian term for drum, is a font primarily comprised of noteheads. It contains a vari-
ety of symbols particularly useful for percussion notation, including instrument noteheads and 
several articulation marks. Tamburo also contains a full set of symbols for use in hymnal shape 
note music, where each note of the scale is displayed with a unique notehead. Moreover, Tamburo 
expands your choice of accidentals for quarter-tone music.

Finale Engraver’s Font (included with the purchase of Finale)

The Finale Engraver’s font set was developed by Bruce Nelson to meet the Music Publisher Asso-
ciation's music font design specifications. It includes a larger notehead with a different notehead 
angle. It also includes “Let Ring” noteheads, “Double-stopped unison” noteheads, “Trill to” note-
heads, “Tone-cluster” noteheads, variations on dynamics and articulations, tempo markings, and 
harp pedaling symbols. (See ENGRAVER FONT)

The Jazz Font (included with the purchase of Finale, Finale Allegro, or Finale PrintMusic!)

The Jazz Font, the premiere hand written music font, comes with handwritten text, percussion and 
guitar symbol fonts as well.

November by Robert Piéchaud ($70)

November is a rich set made up of more than 330 symbols, from basic shapes such as note heads, 
clefs and rests, up to rarer characters like microtonal accidents, plain-song clefs or baroque orna-
ments. Based on the fractal concept, in which details are as important as the whole, even for very 
small symbols such as music characters, November has been crafted with total attention to details 
and a new coherence. November is inspired by the spirit of traditional music engraving art... but 
with a revolutionary graphic idea!

http://www.klemm-music.de/november
Klemm Music Technology
Waldstieg 2
D-37133 Friedland, Germany

Neuma and Neuma Symbol (part of the Medieval plug-in package) by Robert Piéchaud ($200)

The Medieval plug-in offers you the possibility to produce professional transcriptions of early 
music easily, from Gregorian square notation to Italian mixed notation, with a beautiful rendering. 
Medieval gives you a wide choice of tools such as automatic recognition of neumes (more than 
80!) up to 7 notes, liquescences, automatic placing of the “direct”, stemmed note groupings, and 
numerous special symbols: quilisma, rests, plicas, large ligatures, black-void notation, etc.

With Medieval you will get:

1. a Finale plug-in (installed into the Finale plug-in Folder) consisting of a new palette with 12 
graphic-oriented tools;
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2. 2 new fonts, Neuma and Neuma Symbol, for PostScript and TrueType printers;
3. 2 new default files; 
4. samples such as Gregorian, Franconian, Machaut´s Mass, etc.; 
5. a real handbook with a complete english tutorial

http://www.klemm-music.de/medieval
Klemm Music Technology
Waldstieg 2
D-37133 Friedland, Germany

Toccata and Fughetta fonts by Blake Hodgetts (Shareware: $30 for both) 

Hundreds of additional musical symbols; available for Macintosh and Windows. The full package 
includes TrueType and PostScript fonts, custom Finale libraries, character charts, stem connection 
settings and full documentation. Additional information and downloadable TrueType versions 
available at the following locations: 

 ftp://ftp.shsu.edu/pub/finale/
TocFug.zip [Windows]
TocFug.sit.hqx [Macintosh]
TocFugRead.txt [Information text file] 
http://www.efn.org/~bch/AboutFonts.html

Contact the author at bhodgetts@symantec.com, or write: 
Blake Hodgetts
4495 Thunderbird Dr.
Eugene, OR 97404

GraceNotes & Crescendo ($40 + $7.50 UPS ground)

These music fonts give another look to basic notational symbols (quarter note head, Treble clef, 
etc.) and provide a greater selection of percussion symbols, symbols for Gregorian Chant, Harp 
Pedal markings and much more. 

Available for Macintosh and Windows.
Casady & Greene
22734 Portola Drive
Salinas, CA 93908-1119
Phone 800-359-4920
or
408-484-9228
Fax 408-484-9218

Sonata ($29.95 + your choice of $6 or $9 shipping) 

The first music font, and a favorite among computer copyists. This font has fewer symbols than 
most other fonts but remains popular because of its “classic” look. Available for Macintosh and 
Windows.

Adobe Systems Incorporated
PO Box 6458
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Salinas, CA 93912-6458
General Phone: (800) 833-6687
Image Club (to order fonts on floppy) (800) 661-9410

Also, you can preview all of Adobe's fonts on their Type On Call CD-ROM for $49. If you then 
choose to purchase the code to unlock a specific font from the CD, there is an additional charge. 
For Sonata, this fee is $25.

Metronome & MetTimes ($24.95 + $3 shipping)

A music font that works like a text font. A collection of number sets, text characters and built-in 
music characters lets you mix text with markings and music symbols without changing fonts. 
MetTimes includes the largest collection of dynamics in any music font. Available for Macintosh 
and Windows. DVMarticulations is included free of charge.

DVM Publications
104 Woodside Rd.
Suite A-202
Haverford, PA 19041
Phone/Fax: (610) 896-0996
E-Mail: SPLsm@aol.com

Kidnotes ($39.00 + $3 shipping)

Offers noteheads with letters embedded in them. Intended for music for beginning music students, 
this font can be used to display note names on noteheads. Available for Macintosh and Windows. 
DVMarticulations is included free of charge.

DVM Publications
104 Woodside Rd.
Suite A-202
Haverford, PA 19041
Phone/Fax: (610) 896-0996
E-Mail: SPLsm@aol.com

Golden Age ($65 includes US postage)

“GoldenAge” is a full-featured package of four typefaces inspired by the clear, highly legible look 
of professionally hand-copied sheet music. Available for either Windows or Macintosh, the pack-
age includes PostScript and TrueType versions, full documentation on their use, sample text/chord 
suffix libraries and a Default file template.GoldenAge has a highly readable, informal design 
appropriate for use in big band charts, jingles, record dates, or anywhere a commercially hand-
copied look is desirable. Session players prefer the look of GoldenAge because of its familiarity 
and readability.The set of 4 fonts (2 music/2 text) is available for $65.00 US (postpaid) from:

Donald Rice Music Preparation
P.O. Box 110838
Brooklyn, NY 11211 U.S.A.
phone: 718-486-7307
email: MelRoc@aol.com

*Please specify* Macintosh or Windows platform.
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Sample of GoldenAge are available for viewing on the GoldenAge web page at 
http://members.aol.com/melroc/GA.html

Susato ($149 US only – plus shipping; others please call or Fax)

The Susato PostScript Type 1 and TrueType character sets take the aesthetics of traditional note 
engraving into account and thus greatly enhance the printouts made with Finale. The standard 
character set is complemented by an accordion register font, a guitar tablature font, and a note 
head font. Available for Mac and Windows.

     Contact: Werner Eickhoff
     MusicFontLab
     Schauinslandstrasse 99
     D-79100 Freiburg im Brsg.
     Germany
     Phone +49-761-29970
     Fax +49-761-29970

The Figured Bass font greatly simplifies the creation and entry of figured bass symbols. Its fea-
tures include: 

1.  Direct entry (e.g. as lyrics in Finale) of numbers, special symbols and accidentals without 
changing font or size within the same verse. 

2. Direct entry of the characters mentioned beside or below each other within only one “sylla-
ble”.

3. Enter the numbers 2,4,5,6,7,9 with accidental or as struck-through characters. The numbers 
“5+” and “7+” are even available in two different versions.

4. Easy-to-remember keyboard layout. A similar font exists in a version for German users, called 
FinalGeneralBass. The very important difference is only the keyboard-layout for German sys-
tem.

5. Great flexibility because of many available characters and several different entry methods.
The full version costs $50 (or DM 45.-) and can be ordered from 

Ansgar Krause
Erftweg 29
47807 Krefeld
Germany

INTERNET: AnsgarKrause@t-online.de

Be sure to include the following information: Version for Windows or Macintosh, US-Version or 
German, and via e-mail or disk ($5 extra).
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 The Really Loud Font Company offers a variety of music related fonts. Visit their web site at 
http://members.aol.com/LoudFonts/Home.htm for current pricing and product information. Basic 
Set: $90, Supplementary Sets: $40 each -- all three sets for $90, or all of the items lists below for 
$150

TempiFont Family: A set of 4 fonts which facilitates Tempo Markings, Metric Modulations, 
Swing Time Notations, etc.

ThesisFont: Provides Parenthetic Dynamics, Microtonal Accidentals, Harp and Organ Pedall-
ings, Brackets, Stimmen and miscellaneous articulations.

MetricFont: Notates any type of time signature whether compound additive, irregular, irratio-
nal, etc.

Basic Allotment Library -- re-space music (especially cross rhythms) cleanly and evenly in a 
minimum of horizontal space.

(Supplementary Sets)

TallMetricFonts and MultiMaster MetricFonts -- Notate large size (conductors style) time 
signatures as in Metric Font. MultiMaster fonts enhance precision and control for Mac OS 
users.

FiguredBass Fonts --- Notate, figures, progressions and basic Schenkerian notations. Both 
within FINALE and also in text files.

Custom Allotment Libraries -- re-space music (especially cross rhythms) cleanly and evenly 
in 14 different proportional spacings.

Mail orders to: Konanur Inc., 155 East 23rd Street, Suite 302, New York, NY 10010-3700 or call 
212.475.3351 and leave your address if you desire a catalog.

E-Mail (questions, comments and requests for information) to: LoudFonts@aol.com 

BlueNotz by Thomas Williams ($60)

BlueNotz™ fonts for the Macintosh, and soon for Windows, has been designed to replace the 
stiff, formal look of engraver based fonts with the look and “feel” of handwritten music copy.

There are three components of the font bundle. BlueNotz™ is the main symbol font and is used 
for generating many of characters and symbols used for written music. BlueText™ is used for 
titles, score expressions, and any other text applications and come with the added feature of being 
able to create pre-built text highlighters such as over and underscores. BlueChords™, the newest 
addition to the family, is used for chords and chord suffixes and includes many commonly used 
pre-built chord suffixes.

http://www.musink.net/BlueNotz.html
Musink
22103 Stocklmeir Court
Cupertino, Ca 95014


	Chapter 29: Fonts
	Fonts
	Most items you see in Finale are created with font characters. In addition to items created with ...
	PostScript, TrueType and ATM (Adobe Type Manager)
	All fonts included with Finale come with a Type 1 PostScript font and a True Type font. A PostScr...
	Prior to the introduction of TrueType fonts, Finale came with bit map fonts which provided an on-...

	Where are the fonts installed?
	The Finale Installer automatically installs the Maestro, Maestro Wide, Maestro Percussion, Petruc...

	How to identify font types
	PostScript fonts are recognized by .PFM or .PFB extensions. TrueType fonts have a TT icon, and .T...
	Additional discussions of fonts and font selections appear in individual entries, such as Lyrics;...

	To globally change a musical element’s font
	With this technique you can change the font for a single element of the music, such as the clefs ...

	To change music fonts
	If you choose not to use Finale’s own font, Maestro, you can substitute any other music font.

	To change every occurrence of one font to another
	You can use Finale’s Data Check submenu to change every occurrence of one font and size to anothe...

	To change every occurrence of a font to a different size
	With this technique, you can scale every occurrence of a certain font that’s used in your documen...

	To change the music font of noteheads on a staff by staff basis
	To use Tamburo for your percussion notation, assign it as the notehead font in each staff or as t...

	To eliminate dimmed font names from a document’s font lists
	Finale stores a font list with each document you create. The list contains the fonts that were av...
	This procedure removes dimmed font names from a document’s font selection boxes.


	Change Fonts Plug-in
	How to get there
	Select Change Fonts from the Plug-ins Menu. See Plug-ins Menu for more information on plug- ins.

	What it does
	The Change Fonts plug-in allows you to change the font globally for specific items in your score ...


	Engraver Font
	The Alternate Notehead Sets
	“Let Ring” Noteheads.
	These are noteheads with the let ring symbol. By having the let ring symbol directly attached to ...
	0131
	0132
	0133
	0134
	0135
	0136
	0137
	0138
	0139
	0142
	0143
	0144
	0145
	0146
	0147
	0148
	0149
	0150
	0151
	0152
	0153
	0154
	0155
	0156
	0157
	0158
	0159
	0193
	0170
	0163
	0162
	0176
	0164
	0166
	0165
	0187
	0218
	0219
	0220
	0221
	0222
	0223
	0224
	0161
	0225
	39
	34
	0190
	0174

	Also included are the two “let ring” symbols for input with the articulation tool.
	I
	i
	sh-I
	I


	“Double-stopped unison” Noteheads.
	sh-Q
	sh-H
	X

	“Trill to” Noteheads
	Set One: Full Size
	These noteheads are to make consistent the process of setting up “trill to” notes when they are t...
	0194
	Set Two: 75% Reduction
	These noteheads are already reduced to 75% and can be used as “trill to” notes for use within the...
	0180

	Indeterminate and Determinate “Tone-cluster” Noteheads
	These noteheads allow for a quick and consistent way to input tone-clusters. After inputting note...
	Indeterminate
	0201
	Determinate
	for use in quarter and half note clusters
	0210
	for use in whole note clusters
	0211

	Dynamics
	Type away! Make whatever dynamic possible.
	There are two sets of parenthesis for use. The f and p markings need more space than the other sy...

	Articulations
	Engraver Font Set
	0190
	0188
	D
	sh-D
	E
	sh-E
	tremolos
	æ
	º
	d
	D
	e
	E
	0193
	0170
	0163
	0162
	0176
	0164
	0166
	0165
	brackets
	¡
	™
	£
	¢
	°
	§
	¶
	•
	0169
	0253
	Bartok pizz.
	©
	˝
	0187
	system divider
	ª

	Engraver Font Extras
	[
	]
	sh-[
	sh-]
	conducting symbols
	[
	]
	= 1 beat
	{
	}
	= 2 beats
	0210
	0212
	0211
	“
	‘
	= 3 beats
	”
	= 4 beats
	0185
	harp mute
	¹
	,
	sh - ,
	.
	trills
	,
	<
	.
	\
	sh-\
	;
	sh-;
	`
	sh-`
	(within staff) articulations
	\
	|
	;
	:
	`
	~


	Engraver Text Fonts
	Tempos
	Q = q C = c \ = \ (use with quarter and half notes)
	H = h M = m sh-\ = | (use with quarter and half notes)
	E = e (0130) = Ç ; = ; (use with whole notes)
	X = x D = d (use with quarter and half notes) sh-; = : (use with whole notes)
	W = w (0235) = Î (use with whole notes)
	U = u sh-[= {
	V = v sh-] = }
	B = b
	examples: q=100 {h=60} q|qd

	Harp Pedaling
	Single Line
	F = f, S = s, N = n
	sh-A = A, etc.
	L = l
	example: DsCsBnlEnFsGsAs
	Double Line
	(above plus)
	G = gg, sh-S = S, sh-N = N (0186) = º, (0141) = ç, (0182) = ¶,
	K = k, R = r, sh-R = R
	/ = (space for letter), sh-/ = (space for accidental)
	examples: kE¶nSFçsSGºsNAs
	rEºnNR
	Graphic
	O = o, sh-O = O, P = p sh-P = P
	example: ppOPOppp


	Maestro Font
	Notes and Augmentation Dot
	Notes and Augmentation Dot
	Shift-W
	W
	Double Whole Note (Breve)
	Shift-E
	E
	Eighth Note - Downstem
	Alt+0135
	á
	Alternate Double Whole Note (Breve)
	X
	x
	Sixteenth Note - Upstem
	Alt+0221
	›
	Breve
	Shift-X
	X
	Sixteenth Note - Downstem
	W
	w
	Whole Note
	Alt+0169
	©
	Small Quarter Note - Upstem
	H
	h
	Half Note - Upstem
	Alt+0237
	Ì
	Small Quarter Note - Downstem
	Shift-H
	H
	Half Note - Downstem
	;
	;
	Small Eighth Note (Grace Note)- Upstem
	Q
	q
	Quarter Note - Upstem
	Shift-;
	:
	Small Eighth Note (Grace Note)- Downstem
	Shift-Q
	Q
	Quarter Note - Downstem
	Alt+0201
	…
	Slashed Grace Note
	E
	e
	Eighth Note - Upstem
	Alt+0242
	Ú
	Small Quarter Note Equals

	Noteheads
	Noteheads
	.
	.
	Augmentation Dot
	Alt+0231
	Á
	Right-facing Triangle
	Alt+0250
	˙
	Half Notehead
	Alt+0224
	‡
	Filled Upside Down Triangle
	Alt+0207
	œ
	Quarter/Eighth Notehead
	Alt+0225
	·
	Diamond
	Alt+0192
	¿
	Non-pitched notehead
	Alt+0226
	‚
	Filled Diamond
	Y
	y
	Triangle
	Alt+0208
	–
	Filled Square
	Alt+0198
	Æ
	Upside Down Triangle
	Alt+0209
	—
	Filled Triangle
	L
	l
	Left-facing Triangle
	Alt+0173
	�
	Square
	Shift-L
	L
	Circle
	Alt+0231
	Á
	Right-facing Triangle
	Alt+0194
	¬
	Rectangle
	Alt+0224
	‡
	Filled Upside Down Triangle
	Alt+0180
	¥
	Angled rectangle

	Flags
	Flags
	J
	j
	First Upstem Flag
	R
	r
	Sixteenth Note Upstem Flag
	Shift-J
	J
	First Downstem Flag
	Shift-R
	R
	Sixteenth Note Downstem Flag
	Shift-K
	K
	Second Upstem Flag
	Alt+0251
	˚
	Second Upstem Flag - Old
	Alt+0239
	Ô
	Second Downstem Flag
	Alt+0240
	ð
	Second Downstem Flag - Old
	Alt+0144
	ê
	Sixteenth Note Upstem Flag (Use Petrucci secondary flag setting)
	Alt+0146
	í
	Sixteenth Note Downstem Flag (Use Petrucci secondary flag setting)
	Alt+0145
	ë
	Second Upstem Flag (Use Petrucci secondary flag setting)
	Alt+0147
	ì
	Second Downstem Flag (Use Petrucci secondary flag setting)

	Accidentals
	Accidentals
	Shift-3
	#
	Sharp
	Alt+0233
	È
	Small Natural
	A
	a
	Courtesy Sharp
	Alt+0210
	“
	Small Courtesy Natural
	Shift-I
	I
	Small Sharp
	Alt+0186
	º
	Double-Flat
	[
	[
	Small Courtesy Sharp
	Alt+0140
	å
	Courtesy Double-Flat
	B
	b
	Flat
	Alt+0211
	”
	Small Courtesy Double-Flat
	Shift-A
	A
	Courtesy Flat
	Alt+0220
	‹
	Double-Sharp
	I
	i
	Small Flat
	Alt+0129
	Å
	Courtesy Double- Sharp
	Shift-[
	{
	Small Courtesy Flat
	[
	]
	Small Courtesy Double-Sharp
	N
	n
	Natural
	Alt+0245
	ı
	Quarter Tone Flat
	Shift-N
	N
	Courtesy Natural
	Shift-4
	$
	Quarter Tone Sharp

	Rests
	Rests
	Alt+0227
	„
	Double-Whole Note Rest
	Alt+0197
	Å
	Sixteenth Note Rest
	Alt+0183
	·
	Whole Note Rest
	Alt+0168
	®
	Thirty-Second Note Rest
	Alt+0238
	Ó
	Half Note Rest
	Alt+0244
	Ù
	Sixty-Fourth Note Rest
	Alt+0206
	Œ
	Quarter Note Rest
	Alt+0229
	Â
	One Hundred Twenty-Eighth Note Rest
	Alt+0228
	‰
	Eighth Note Rest

	Dynamics
	Dynamics
	F
	f
	Forte
	Alt+0141
	ç
	Sforzando
	Shift-F
	F
	Mezzo forte
	Alt+0130
	Ç
	Sforzando-piano
	Alt+0196
	ƒ
	Fortissimo
	Alt+0182
	¶
	Sforzando-pianissimo
	Alt+0236
	Ï
	Fortississimo
	S
	s
	s for dynamic combinations
	Alt+0235
	Î
	Louder than Fortississimo
	Shift-S
	S
	Sforzando or Sforzato
	P
	p
	Piano
	Alt+0167
	ß
	Sforzando or Sforzato
	Shift-P
	P
	Mezzo piano
	Alt+0234
	Í
	Forte-piano
	Alt+0185
	¹
	Pianissimo
	Z
	z
	z for dynamic combinations
	Alt+0184
	¸
	Pianississimo
	Shift-Z
	Z
	Forzando
	Alt+0175
	Ø
	Softer than Pianississimo
	Alt+0189
	½
	m for dynamic combinations
	Alt+0142
	é
	r for dynamic combinations
	Alt+0150
	ñ
	n for dynamic combinations

	Articulations
	Articulations
	.
	.
	Staccato
	Alt+0248
	¯
	Tenuto with Staccato
	Shift-.
	>
	Accent
	Shift-U
	U
	Fermata - Above
	Alt+0223
	ﬂ
	Accent with Staccato
	U
	u
	Fermata - Below
	Alt+0249
	˘
	Accent with Staccato
	Shift-`
	~
	Trill
	V
	v
	Marcato
	Alt+0217
	Ÿ
	Trill
	Shift-6
	^
	Marcato
	M
	m
	Mordent, Trill
	Alt+0172
	¨
	Marcato with Staccato
	Shift-M
	M
	Mordent
	Alt+0232
	Ë
	Marcato with Staccato
	Alt+0178
	²
	Upbow
	-
	-
	Tenuto
	Alt+0179
	³
	Downbow
	Shift-,
	<
	Tenuto with Staccato
	Shift-T
	T
	Grupetto (Turn)
	Alt+0161
	°
	Pedal Down
	Shift-1
	!
	Measured Tremolo
	Shift-8
	*
	Pedal Up
	Shift-2
	@
	Measured Tremolo
	G
	g
	Rolled Chord - Arpeggio
	Alt+0190
	æ
	Unmeasured Tremolo
	Shift-’
	"
	Caesura (Pause, Railroad tracks)
	Shift-9
	(
	Left Parenthesis
	Alt+0201
	…
	Slashed Grace Note
	Shift-0
	)
	Right Parenthesis
	O
	o
	Natural Harmonic
	'
	'
	Rounded Marcato
	Shift-O
	O
	Harmonic
	Alt+0174
	Æ
	Rounded Marcato
	Alt+0132
	Ñ
	Augmented
	Alt+0171
	´
	Marcato
	,
	,
	Pause (Breath Mark)
	Alt+0216
	Ø
	Marcato
	Alt+0133
	Ö
	Pause (Breath Mark)
	Alt+0137
	â
	Accented Tenuto
	Alt+0181
	µ
	Mordent, Trill
	Alt+0138
	ä
	Accented Tenuto

	Smart Shapes
	Smart Shapes
	Alt+0195
	Ã
	Ottava
	`
	`
	Double Ottava basso
	Alt+0215
	×
	Ottava basso
	Alt+0134
	Ü
	Double Ottava
	Alt+0131
	É
	Ottava
	Alt+0217
	Ÿ
	Trill
	Alt+0219
	¤
	Double Ottava
	Shift-`
	~
	Trill

	Repeats and Alternate Notation
	Repeats and Alternate Notation
	Shift-5
	%
	Segno
	Alt+0213
	’
	Large Slash
	Alt+0222
	ﬁ
	“To Coda”
	Alt+0243
	Û
	Small Slash
	Alt+0212
	‘
	Measure Repeat
	Shift-\
	|
	Whole and Half Note Diamond
	Alt+199
	«
	Two-Measure Repeat
	Alt+0218
	⁄
	Double Whole Note Diamond
	Alt+159
	ü
	Segno
	Alt+203
	À
	Slash

	Clefs
	Clefs
	Shift-7
	&
	G Clef
	T
	t
	Bass 8vb
	Shift-B
	B
	C Clef
	Alt+0160
	†
	Treble 8va
	Shift-/
	?
	F Clef
	Alt+0230
	Ê
	Bass 8va
	Alt+0214
	÷
	Percussion Clef
	/
	/
	Natural Clef
	Shift-V
	V
	Treble 8vb
	Alt+0139
	ã
	Percussion Clef

	Staves and Barlines
	Staves and barlines
	=
	=
	Staff Lines
	Alt+0241
	Ò
	Dotted Barline
	\
	\
	Barline
	Shift - -
	_
	Ledger Line

	Time Signature and Multimeasure Rest numbers
	Time Signature and Multimeasure Rest numbers
	C
	c
	Common Time
	6
	6
	Number 6
	Shift-C
	C
	Cut Time
	7
	7
	Number 7
	1
	1
	Number 1
	8
	8
	Number 8
	2
	2
	Number 2
	9
	9
	Number 9
	3
	3
	Number 3
	0
	0
	Number 0
	4
	4
	Number 4
	Alt+0246
	ˆ
	Plus sign
	5
	5
	Number 5
	Sh-=
	+
	Plus sign

	Chord Symbols and Harmonics
	Chord Symbols and Harmonics
	Alt+0132
	Ñ
	Augmented Chord
	Alt+0191
	ø
	Half Diminished Chord
	Alt+0247
	˜
	Diminished Chord
	Alt+0177
	±
	Major Chord

	Percussion Notation
	Percussion Notation
	Y
	y
	Cymbal - Closed Notehead
	Shift-Y
	Y
	Cymbal - Open Notehead

	Other Notation Symbols
	Other Notation Symbols
	K
	k
	Dot
	Shift - ]
	}
	Closed Parenthesis
	Shift-G
	G
	Acute
	Alt+0200
	»
	Equal sign
	Alt+0193
	¡
	Small 1
	Alt+0164
	§
	Small 6
	Alt+0170
	™
	Small 2
	Alt+0166
	¶
	Small 7
	Alt+0163
	£
	Small 3
	Alt+0165
	•
	Small 8
	Alt+0162
	¢
	Small 4
	Alt+0187
	ª
	Small 9
	Alt+0176
	°
	Small 5
	Alt+0188
	º
	Small 0
	Alt+0136
	à
	Colon for italic numbers


	Jazz Text Font
	Below is a list of the special characters and their keystrokes. The primary special characters in...
	Brackets
	[
	[
	\
	\
	]
	]
	[H\a\r\m\o\n\ \m\u\t\e]
	[H\a\r\m\o\n\ \m\u\t\e]
	Shift-[
	{
	Shift-\
	|
	Shift-]
	}
	{S|o|l|o}
	{S|o|l|o}
	Shift-`
	~
	~1}
	~1}
	Alt+0128
	Ä
	Alt+0129
	Å
	Alt+0130
	Ç
	left bracket, character, middle, character... right bracket
	Ä2nÅdÅ ÅTÅiÅmÅeÅ ÅOÅnlyÇ
	Alt+0133
	Ö
	Alt+0134
	Ü
	Alt+0135
	ªá
	left bracket, character, middle, character... right bracket
	ÖTÜaÜkÜeÜ ÜRÜeÜpÜeÜaÜtÜ ÜoÜnÜ D.S.á
	Alt+0150
	ñ
	Alt+0151
	ó
	Alt+0152
	ò
	left bracket, character, middle, character... right bracket
	ñSótóaórótó óHóeóróeò
	Alt+0154
	ö
	Alt+0155
	õ
	Alt+0156
	ú
	left bracket, character, middle, character... right bracket
	öDõ.õSõ.õ õaõlõ Fineú
	Alt+0157
	ù
	Alt+0158
	û
	Alt+0159
	ü
	left bracket, character, middle, character... right bracket
	ù1ûsûtû ûTûiûmûeû ûOûnlyü
	Alt+0160
	†
	Alt+0161
	°
	Alt+0162
	¢
	left bracket, character, middle, character... right bracket
	†R°e°p°e°a°t° °f°o°r° solos¢
	Alt+0163
	£
	Alt+0164
	§
	Alt+0165
	•
	left bracket, character, middle, character... right bracket
	£F§i§n§e•
	Alt+0166
	¶
	Alt+0167
	ß
	Alt+0168
	®
	left bracket, character, middle, character... right bracket
	¶3ßrßdß ßchorus®
	Alt+0175
	Ø
	Alt+0176
	°
	Alt+0177
	±
	left bracket, character, middle, character... right bracket
	Ø1°s°t° °X±
	Alt+0178
	²
	Alt+0179
	³
	Alt+0180
	¥
	left bracket, character, middle, character... right bracket
	²R³e³p³e³a³t³ ³f³o³r³ ³solos¥
	Alt+0181
	µ
	Alt+0182
	¶
	Alt+0183
	·
	left bracket, character, middle, character... right bracket
	µS¶t¶a¶r¶t Here·
	Multimeasure Rests

	Alt+0170
	™
	Alt+0171
	´
	Alt+0172
	¨
	™ 8 bars ¨
	™´´´´¨
	Rehearsal Letters

	Alt+0216
	Ø
	A
	Alt+0217
	Ÿ
	B
	Alt+0218
	⁄
	C
	Alt+0219
	¤
	D
	Alt+0220
	‹
	E
	Alt+0221
	›
	F
	Alt+0222
	ﬁ
	G
	Alt+0223
	ﬂ
	H
	Alt+0224
	‡
	I
	Alt+0225
	·
	J
	Alt+0226
	‚
	K
	Alt+0227
	„
	L
	Alt+0228
	‰
	M
	Alt+0229
	Â
	N
	Alt+0230
	Ê
	O
	Alt+0231
	Á
	P
	Alt+0232
	Ë
	Q
	Alt+0233
	È
	R
	Alt+0234
	Í
	S
	Alt+0235
	Î
	T
	Alt+0236
	Ï
	U
	Alt+0237
	Ì
	V
	Alt+0238
	Ó
	W
	Alt+0239
	Ô
	X
	Alt+0240
	ð
	Y
	Alt+0241
	Ò
	Z
	Music Notation Items

	Alt+0140
	å
	Quarter Note
	Alt+0141
	ç
	Half Note
	Alt+0142
	é
	Whole Note
	Alt+0139
	ã
	Quarter Note =
	Alt+0137
	â
	Eighth Note
	Alt+0138
	ä
	Sixteenth Note
	Alt+0132
	Ñ
	Flat
	Alt+0136
	à
	Natural
	Alt+0243
	Û
	Coda with enclosure
	Alt+0244
	Ù
	Dal Segno with enclosure
	Alt+0245
	ı
	Coda
	Alt+0246
	ˆ
	Dal Segno
	Alt+0242
	Ú
	Blank enclosure
	Other Text Items

	Alt+0192
	¿
	1
	Alt+0193
	¡
	2
	Alt+0194
	¬
	3
	Alt+0195
	Ã
	4
	Alt+0196
	ƒ
	5
	Alt+0197
	Å
	6
	Alt+0198
	Æ
	7
	Alt+0199
	«
	8
	Alt+0200
	»
	9
	Alt+0191
	ø
	0
	Alt+0201
	…
	1st Chorus
	Alt+0205
	 Õ
	2nd Chorus
	Alt+0203
	À
	3rd Chorus
	Alt+0204
	Ã
	3rd Chorus
	Alt+0131
	É
	Fine
	Alt+0153
	ô
	™
	Alt+0169
	©
	©
	Alt+0174
	Æ
	®
	Alt+0145
	ë
	Single quote
	Alt+0146
	í
	Single quote
	Alt+0147
	ì
	Double quote
	Alt+0148
	î
	Double quote
	Alt+0188
	º
	1/4
	Alt+0189
	½
	1/2
	Alt+0190
	æ
	3/4
	Alt+0215
	×
	X


	Double whole notes
	The double whole note, or breve (v or b ) has a duration of eight beats. Either notehead may also...
	To substitute the b notehead for the v notehead globally
	Follow these instructions if you want Finale to use the b default v notehead for the double whole...

	To substitute the b notehead on a note-by-note basis
	See Note shapes—To change the shape of a notehead.


	Shape Note music
	In some hymnal music, each note of the scale has its own notehead, regardless of key. In Tamburo,...
	Key
	1
	2
	3
	4
	5
	6
	7
	8
	9
	Alone
	1
	2
	3
	4
	5
	6
	7
	8
	9
	With Shift
	!
	@
	#
	$
	%
	^
	&
	*
	(


	Flags
	See also Beaming; Stems.
	You have considerable control over the flags on single eighth notes (and smaller values) in Final...
	To change the character assignment for a flag
	To use Straight Flags
	Straight Upstem Flag
	115
	S
	Straight Downstem Flag
	83
	shift-S
	Straight Upstem Flag
	114
	R
	Straight Downstem Flag
	114
	R

	To adjust the placement of Horizontal and Angled Straight Flags

	Unknown Font dialog box
	How to get there
	From the File Menu, choose Open Library. Double-click the name of a library that was created with...

	What it does
	You’ll encounter this dialog box when you try to open a library of symbols or expressions that we...


	Alternative music fonts
	The following is a list of some of the fonts which are available to the Finale user:
	Maestro, Maestro Percussion and Maestro Wide (included with the purchase of Finale)
	Finale’s default music font developed for Coda Music Technology by Blake Hodgetts (see also Tocca...
	Petrucci (included with the purchase of Finale, Finale Allegro, or Finale PrintMusic!)
	This music font is called Petrucci, named for Ottaviano Petrucci, the sixteenth-century Italian w...
	Tamburo (included with the purchase of Finale)
	Tamburo, an Italian term for drum, is a font primarily comprised of noteheads. It contains a vari...
	Finale Engraver’s Font (included with the purchase of Finale)
	The Finale Engraver’s font set was developed by Bruce Nelson to meet the Music Publisher Associat...
	The Jazz Font (included with the purchase of Finale, Finale Allegro, or Finale PrintMusic!)
	The Jazz Font, the premiere hand written music font, comes with handwritten text, percussion and ...
	November by Robert Piéchaud ($70)
	November is a rich set made up of more than 330 symbols, from basic shapes such as note heads, cl...
	http://www.klemm-music.de/november
	Klemm Music Technology
	Waldstieg 2
	D-37133 Friedland, Germany
	Neuma and Neuma Symbol (part of the Medieval plug-in package) by Robert Piéchaud ($200)
	The Medieval plug-in offers you the possibility to produce professional transcriptions of early m...
	With Medieval you will get:
	1. a Finale plug-in (installed into the Finale plug-in Folder) consisting of a new palette with 1...
	2. 2 new fonts, Neuma and Neuma Symbol, for PostScript and TrueType printers;
	3. 2 new default files;
	4. samples such as Gregorian, Franconian, Machaut´s Mass, etc.;
	5. a real handbook with a complete english tutorial
	http://www.klemm-music.de/medieval
	Klemm Music Technology
	Waldstieg 2
	D-37133 Friedland, Germany
	Toccata and Fughetta fonts by Blake Hodgetts (Shareware: $30 for both)
	Hundreds of additional musical symbols; available for Macintosh and Windows. The full package inc...
	GraceNotes & Crescendo ($40 + $7.50 UPS ground)
	These music fonts give another look to basic notational symbols (quarter note head, Treble clef, ...
	Sonata ($29.95 + your choice of $6 or $9 shipping)
	The first music font, and a favorite among computer copyists. This font has fewer symbols than mo...
	Also, you can preview all of Adobe's fonts on their Type On Call CD-ROM for $49. If you then choo...
	Metronome & MetTimes ($24.95 + $3 shipping)
	A music font that works like a text font. A collection of number sets, text characters and built-...
	Kidnotes ($39.00 + $3 shipping)
	Offers noteheads with letters embedded in them. Intended for music for beginning music students, ...
	Golden Age ($65 includes US postage)
	“GoldenAge” is a full-featured package of four typefaces inspired by the clear, highly legible lo...
	Sample of GoldenAge are available for viewing on the GoldenAge web page at http://members.aol.com...
	Susato ($149 US only – plus shipping; others please call or Fax)
	The Susato PostScript Type 1 and TrueType character sets take the aesthetics of traditional note ...
	The Figured Bass font greatly simplifies the creation and entry of figured bass symbols. Its feat...

	1. Direct entry (e.g. as lyrics in Finale) of numbers, special symbols and accidentals without ch...
	2. Direct entry of the characters mentioned beside or below each other within only one “syllable”.
	3. Enter the numbers 2,4,5,6,7,9 with accidental or as struck-through characters. The numbers “5+...
	4. Easy-to-remember keyboard layout. A similar font exists in a version for German users, called ...
	5. Great flexibility because of many available characters and several different entry methods.
	The full version costs $50 (or DM 45.-) and can be ordered from
	Be sure to include the following information: Version for Windows or Macintosh, US-Version or Ger...
	The Really Loud Font Company offers a variety of music related fonts. Visit their web site at htt...
	Mail orders to: Konanur Inc., 155 East 23rd Street, Suite 302, New York, NY 10010-3700 or call 21...
	E-Mail (questions, comments and requests for information) to: LoudFonts@aol.com
	BlueNotz by Thomas Williams ($60)
	BlueNotz™ fonts for the Macintosh, and soon for Windows, has been designed to replace the stiff, ...
	There are three components of the font bundle. BlueNotz™ is the main symbol font and is used for ...
	http://www.musink.net/BlueNotz.html
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